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UNIT STANDARD 7996 

Unit Standard Title  

Operating computer systems  

 

Unit Standard ID 

117902 

 

NQF Level 

3 

 

Credits 

8 

 

Purpose  

A learner accredited with this standard will be able to demonstrate the ability to apply an understanding 
of basic computer operations to a range of computer packages for the successful completion and 
presentation of work-place documentation.  

 

Unit standard range 

Computer systems envisaged by this standard include hardware and software designed to be used in the 
workplace, encompassing the appropriate operating system (e.g. MS Windows 98), computer package (e.g. 
MS Office, Lotus Smart Suite) and electronic communication tools (e.g. MS Mail), where the learner is able 
to competently implement appropriate responses to largely familiar problems based on limited discretion 
and judgement but where he/she has significant responsibility for the quantity and quality of output.  

 

Assumed To Be In Place And Recognition Of Prior Learning 

NQF 1 or General Education and Training Certificate.  

 

Specific Outcomes and Assessment Criteria 

 

Specific Outcome 1: Successfully identify, initiate and perform the appropriate steps in order to access 

information.  

Outcome Notes  
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Successfully identify, initiate and perform the appropriate steps in order to access information and 
navigate within an appropriate/defined computer-based system (identified as being appropriate for the 
defined task), in order to complete a required task within an agreed timeframe.  

Assessment Criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  

 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  

 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  

 

Specific Outcome 2: Identify and select the appropriate computer system process.  

Outcome Notes  

Identify and select the appropriate computer system process (inputs and actions) to reflect a required 
physical operation being recorded, performed or produced (e.g. recording storage allocation of freight, 
printing a document, accessing information from a computerised inventory management system).  

Assessment Criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  

 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  
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 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  

 

Specific Outcome 3: Access data and integrate the data across compatible computer programs.  

Outcome Notes  

Access data and integrate the data across compatible computer programs within a specific computer 
system (e.g. via Internet between Word and Excel).  

Assessment Criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  

 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  

 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  

 

Specific Outcome 4: Take appropriate action to ensure the security and integrity of data.  

Outcome Notes  

Take appropriate action to ensure the security and integrity of data (e.g. daily backups, password 
protection, anti-virus checks within workplace policies and guidelines) taking cognisance of organisational 
security procedures.  

Assessment Criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  
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 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  

 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  

 

Unit Standard Essential Embedded Knowledge 

The learners can understand, explain and apply:  

1. The purposes of, and processes incorporated in (specific) computer systems.  

2. General safety precautions and procedures with respect to computer equipment and storage media and 
their use (e.g. posture, work station ergonomics, electrical fittings).  

3. Routine error and violation messages and the corrective action to resolve the problem.  

4. Basic network concepts and data management from an end user perspective.  

5. Basic computer terminology (e.g. files, enter, discs etc) and concepts associated with them (e.g. save, 
edit, etc).  

6. The function of the hardware components of a computer system.  

7. Where to locate sources of information required by the user (e.g. new technologies, error resolution, 
help tools).  

 

Critical Cross-field Outcomes (CCFO) 

Unit Standard CCFO Identifying Identify and solve problems by demonstrating initiative in taking 

precautionary steps to prevent damage to equipment and data (e.g. ensure sufficient storage space, 

saving regularly).  

Unit Standard CCFO Working Identify and solve problems by demonstrating initiative in taking 

precautionary steps to prevent damage to equipment and data (e.g. ensure sufficient storage space, 

saving regularly).  

Unit Standard CCFO Science Utilise technology by applying basic computer skills to 

organisational/industry systems and personal computer applications (home, internet banking).  

Unit Standard CCFO Demonstrating: Demonstrate initiative by showing an awareness of advances in 

technology to improve work processes and productivity.  

Unit Standard CCFO Contributing: Facilitate self-development by showing initiative in utilising 

computer skills (e.g. CBT courses).  
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SECTION 1: ACCESS INFORMATION 

 

Outcome 

Successfully identify, initiate and perform the appropriate steps in order to access information.  

Outcome Notes  

Successfully identify, initiate and perform the appropriate steps in order to access information and 
navigate within an appropriate/defined computer-based system (identified as being appropriate for the 
defined task), in order to complete a required task within an agreed timeframe.  

Assessment criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  

 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  

 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  
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Information Systems 

An information system is an integrated set of components for collecting, 

storing, processing, and communicating information. 

Business firms, other organizations, and individuals in contemporary society rely on information systems to 
manage their operations, compete in the marketplace, supply services, and augment personal lives. For 
instance, modern corporations rely on computerized information systems to process financial accounts and 
manage human resources; municipal governments rely on information systems to provide basic services to 
its citizens; and individuals use information systems to study, shop, bank, and invest. 

The first large-scale mechanized information system was Herman Hollerith’s census tabulator. Invented to 
process the 1890 U.S. census, Hollerith's machine represented a major step in automation, as well as an 
inspiration to develop computerized information systems.  

One of the first computers used for such information processing was the UNIVAC I, installed in the U.S. 
Bureau of the Census in 1951 for administrative use and in General Electric in 1954 for commercial use.  

Beginning in the 1970s, personal computers brought some of the advantages of information systems to 
small businesses and to individuals, and the invention of the World Wide Web in the early 1990s 
accelerated the creation of an open global computer network.  

This was accompanied by a dramatic growth in digital human communications (e-mail and electronic 
conferences), delivery of products (software, music, and movies), and business transactions (buying, 
selling, and advertising on the Web) 

 

Data And Information 
To explain the difference between data and information, suppose that you present a cheque for R50.00 to 
the cashier at your bank. The transaction gives the bank one of the thousands of pieces of data that it 
processes daily. In addition, your current account has a debit balance of R75,00, but you have an 
overdraft facility of R100.00.  

Before the presentation of the R50.00 cheque, the branch manager is unlikely to be aware of the state of 
your account. You have been operating your accounts within limits set by the bank. When the account is 
updated with the R50.00 withdrawal, the R100.00 overdraft limit is exceeded and this will immediately be 
reported to the branch manager.  

Action may or may not be taken. If it is near the end of the month and your salary is about to be paid in, 
nothing could happen. If, however, it is the start of the month, the manager may write to you pointing out 
that the account is overdrawn beyond the agreed limit. Should you have been reminded of this already 
you may be asked to come into the bank to see the manager. The sooner the manager is alerted to the 
problem, the sooner action can be taken to control the situation. 

The data regarding the transaction is being processed to provide information allowing the bank's business 
to be managed with greater effectiveness to ensure that it operates profitably and without the need to 
write off your debt as a bad one. 
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Data consist of raw facts: 

 Your account has a debit balance of R75 

 You have written a cheque for R50 

 Your overdraft limit is R100 

Once the above pieces of data are organised in a way that the raw facts become meaningful, it becomes 

information.  The collection of facts has an added value that is more than the value of the facts 

themselves.  Your account is now overdrawn by R25 and the bank can now make a decision as to what 
action to take regarding your account. 

It follows that a process is followed in order to turn data into information.  The information processing 
cycle can be represented schematically as shown in the following Figure. 

 

 

 

 

 

 

 

 

 

 

 

 

The process to turn data into information also requires knowledge of ways 

that the information can be made useful to either support specific tasks or 

make decisions. 

 

 

  

DATA PROCESSING INFORMATION 

FEEDBACK 
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This is how data were processed in 1890 when the US government conducted a sensus. 

 

 

THIS COVER OF SCIENTIFIC AMERICAN, AUGUST 30, 1890, DISPLAYS VARIOUS ASPECTS OF HERMAN HOLLERITH'S 

INVENTION 
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AN IBM BUSINESS SYSTEM FROM THE 1950’S. 
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Process Model 

Input 

The gathering and capturing of raw data would be inputs.   

In a payroll system the primary objective is to pay the staff at every pay period. Each employee has 

a record on the payroll master file containing details (information) such as name, employee number, work 
location, grade, income tax number, etc.  There are a variety of ways to pay staff. 

 Payment can be made in cash, by cheque or by credit transfer.  

 Payment can be made weekly, fortnightly, monthly or casually. 

 Employees can be paid on a time rate or on a piece rate.  

 Overtime can be worked.  

Payroll systems are therefore generally complex.  In a factory, time cards may collect the details of an 
employee's attendance. Other data relating to the employee may be collected 
from job tickets, idle time cards and overtime authorisations.  

The documents that provide the raw material for the information processing 

system are called source documents. This data can be collected manually or 

automatically. When a manager has to decide whether or not an information 
system or parts thereof should be automated, the two main criteria are: efficiency 
and economy. 

 

Process 

Once the inputs have been received, the processing of data will begin.  In the 
example above, the process will be as follows:  

When the data is passed on to the wages office it will be: 

 Summarised: The hours worked each day by each employee will be totalled. 

 Validated: The hours worked will be checked to see that there are no unreasonable figures. If an 

employee works overtime, an overtime authorisation form with the supervisor’s signature should 
authorise this. The hours worked should be reconciled with details the employee has entered on 
job jackets and idle time cards, so that: Hours worked = Hours on specified jobs + idle time.  
Procedures such as this ensure that control is maintained over employees' time at work. 
Furthermore, it reveals when work is being done at the most expensive overtime rates. It enables 
the cost of jobs to be calculated precisely and it identifies and quantifies the cost of idle time. 

 Sorted: The records of the employee's working time, with any adjustments for bonuses, are put 

into sequence. The sequence will be the same as that on the employee master file. By doing this, 
the time used when the master file is updated is kept to a minimum. 

 Calculated: For each employee in the organisation the gross wage, the pension contributions 

due, the income tax deductions and other deductions from pay are calculated. Details of the tax 
code, basic rate of pay, and the pension fund contributions are held for each employee as part of 
her master file record. By referring to that data, the tax tables issued by the Receiver of Revenue, 
and the details of the hours worked, the appropriate calculations can be made. It will also be 
necessary to update the accumulating totals for gross pay, taxation, and pension fund in addition 
to making the calculations for the current period.  

 Classified: After the calculations have been made, the payroll can be made up along with the 

pay advice slips. In many organisations employees work at different locations and because of this, 
pay advice slips have to be organised into different groups to make the tasks of distributing them 
easier.  
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 Recorded: The information produced during the preparation of the payroll needs to be recorded 

in a variety of places. This information includes: Pay advice slips Employee records Income tax 
records Pension contribution records Cash analysis Credit transfer instructions Management 
reports Cost records. 

 

Output 

The outputs of the above process would be payment of employee salaries and wages and printing of 
payslips. 

 

Feedback 

The purpose of feedback in this process is to make changes to the input or processing activities.  This is 
usually done when an error occurred, such as the incorrect number of working hours recorded for an 
employee.  Feedback is generated by output. 

The above process of converting data into information can be done manually or with the help of 
computers.  Processing data into information is faster and less time consuming when it is done with a 
computer. 

 

Computer-Based Information Systems 
Until a few years ago all information was processed manually, especially in smaller organisations.  The 
advanced technology of the computer has permitted the following developments: 

 Databases can be created. A database contains all the data generated by an organisation. The 

data can be manipulated to allow the information needs of the organisation to be met. Specialised 
software (data description and data manipulation languages) has been created to ease the 
development of database management systems. 

 On-line updating. Transactions can be recorded as they occur so that the information available 

to management is up to date. This has been a consequence of the failing cost of direct access 
storage technology. 

 Speedier communication. Networks have linked together a wide range of intelligent 

equipment. Because of this, information transmission is speedier and can be directed, if 
necessary, to a wide group of people at little extra cost. 

 Improved software. Spreadsheet programs, graphics packages and word processing programs 

have become popular because they eliminate the repetitious element that occurs in information 
processing and which staff find time consuming. 

 Computer-aided design and computer-aided manufacture (CAD and CAM) have improved 

the manufacturing process. Cars are designed with the aid of a computer that can calculate the 
strength of the design and the resistance of the bodywork to airflow. Robots can also do part of 
the assembly. 

 Mathematical techniques, such as linear programming and critical path analysis can be applied 

routinely to business problems to find the best solutions to these problems. 
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Turning data into information using a computer 

A computer-based computer system is allows the input, processing, output and storage of data to take 
place by making use of a computer.  

 

Components of a computer-based information system 

Some of the components needed for a computer-based system are similar to a manual system, with some 
extra components: 

 Hardware: found in computer systems 

 Software: found in computer systems 

 Data/information: found in manual and computer systems 

 Procedures: found in manual and computer systems 

 People: found in both manual and computer systems 

By its nature, a computer-based information system is driven by people.  Humans are needed to input the 
data, process the data and interpret the outputs.  Being faced with technology the first time can be 
frightening, but we must always remember that computers are built by people for other people to use.   

They also named the various computer components in such a manner that we can all recognise their 
functions.  You have input devices, processing hardware, output devices and storage devices.   

The interaction between people and the computer as far as an information system is concerned happens 
as follows: 

 

Input 

First, a computer user (you) must enter data in a computer, called capturing 
data.  This has to happen in a format that is usable by the computer, but this 
part is very easy as you will see later on.  This is usually done using a form, as 
with a manual system.  For this to happen, the data must be collected and then 
you have to access the software package that you will need to capture the 
data.  By doing this, you are in effect instructing the computer to start with 
data input activities.  You will enter the data by making use of input devices: they keyboard, mouse and 
monitor.  These devices translate your input into digital (electronic) signals that the computer can 
recognise. 

The same procedures as is the case with a manual information system have to be followed.  Someone has 
to check the data before it is entered, all the data has to be entered and after the data has been 
captured, someone must check that all the data has been captured and that it has been captured 
correctly. 

You will use the keyboard and mouse as well as the monitor to capture data. 

 

Process 

Then data has to be processed by the computer, in order for meaningful and useful information to come 
out.  The processing of data can include performing calculations, classifying and sorting the data, 
summarising the data and performing logistical processing activities where information can be listed in a 
specific order. 

Many of these processing functions will be automated, but you may be required to give the computer 
commands for certain functions to happen.  You may, for example, have to tell the computer to do a 
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calculation or the software may ask you questions that you have to respond to.  Most of the processing is 
done by the CPU (Central Processing Unit) and the main memory.  This is found inside the tower.  

 

Output 

Once the data has been processed, the outputs will be available.  The information can now be printed in 
the format as required by the manager or yourself.  An example is the payslips, or a report about the total 
amount of salaries or a demographic report about the employees.  If the system is set up properly, the 
information will be of value to the organisation. 

The output can be in hardcopy, for example printing of reports or other information on paper or 
microfilm.  It can also be in soft copy, meaning that it will be read from the computer monitor.  Although 
we still have the tendency to print reports, we should be moving towards working without paper, so 
employees should learn to read the information from the monitor without printing it first. 

You will also be able to provide information, whether in hard copy or soft copy, with graphics, colour and 
pictures together with text.  Information can also be produced in audio form, such as a telephone number 
given over the phone by directory assistance.  In the near future, we may even be able to enter data by 
talking to the computer instead of typing the data. 

How the information (output) is prepared and distributed would depend on the procedures and business 
processes of the organisation.  Whatever the requirements, once the information has been processed it 
has to be prepared for distribution, distributed and then analysed by the recipients.  Decisions affecting 
the company will then be made according to the output. 

 

Storage 

Once the data has been processed and turned into information, it is stored in the storage devices of the 
computer.  The devices available for storage include: the hard drive, flash drive, floppy disk, CD, DVD or 
tapes.  In computer terms storage is called saving. 

The software will request you to nominate the storage device you wish to store the information on.  Once 
the data and information has been stored you can retrieve it, send it to other computer users, update it, 
make printouts again, store it in a different device or erase it. 

Company policy and procedures should dictate where information is stored and when it should be deleted.  
In this respect, once again, the computer-based system is similar to a manual system where documents 
are filed in a specific format, archived and destroyed after a period of time.  
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Navigating in Excel  
A database is a collection of information that has been organised so that the information is 
easy to access and display in different ways. Databases are used everywhere: at work, in 
the home, in schools, and leisure facilities.  

Real world database examples are a telephone directory, an encyclopaedia, or even a library. 

One of the most common programs that can be used as a database is Microsoft Excel.  Some examples of 
programs that large organisations use are MS Access, SAP and PHP.  

In this manual you will be working with Excel since it is the most common program and can be found on 
most computers in South Africa.   

 

Start Excel 

First, you must start Excel. Click the Start button, point to All Programs, select Microsoft Office and 

then click on Excel  

The Excel desktop, with a blank worksheet pops up on your screen. Do this now, so that you can see what 
the Excel desktop looks like. 
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Moving Around In A Workbook 

Select cells, ranges, rows, or columns 

To select Do this 

A single cell Click the cell, or press the arrow keys to move to the cell. 

A range of cells Click the first cell in the range, and then drag to the last cell, or hold 
down SHIFT while you press the arrow keys to extend the selection.  

A large range of cells Click the first cell in the range, and then hold down SHIFT while you 
click the last cell in the range. You can scroll to make the last cell 
visible. 

All cells on a worksheet Click the Select All button.  

 

To select the entire worksheet, you can also press CTRL+A.  

Note: If the worksheet contains data, CTRL+A selects the 
current region. Pressing CTRL+A a second time selects the 
entire worksheet. 
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Nonadjacent cells or cell 
ranges 

Select the first cell or range of cells, and then hold down CTRL while 
you select the other cells or ranges.  

Note: You cannot cancel the selection of a cell or range of 
cells in a nonadjacent selection without canceling the 
entire selection. 

An entire row or column Click the row or column heading.  

 

Row heading 

Column heading 

You can also select cells in a row or column by selecting the first cell 
and then pressing CTRL+SHIFT+ARROW key (RIGHT ARROW or LEFT 
ARROW for rows, UP ARROW or DOWN ARROW for columns). 

Adjacent rows or columns Drag across the row or column headings. Or select the first row or 
column; then hold down SHIFT while you select the last row or 
column. 

Nonadjacent rows or columns Click the column or row heading of the first row or column in your 
selection; then hold down CTRL while you click the column or row 
headings of other rows or columns that you want to add to the 
selection. 

The first or last cell in a row 
or column 

Select a cell in the row or column, and then press CTRL+ARROW key 
(RIGHT ARROW or LEFT ARROW for rows, UP ARROW or DOWN ARROW 
for columns). 

The first or last cell on a 
worksheet or in a Microsoft 
Office Excel table 

Press CTRL+HOME to select the first cell on the worksheet or in an 
Excel list.  

Press CTRL+END to select the last cell on the worksheet or in an 
Excel list that contains data or formatting. 

Cells to the last used cell on 
the worksheet (lower-right 
corner) 

Select the first cell, and then press CTRL+SHIFT+END to extend the 
selection of cells to the last used cell on the worksheet (lower-right 
corner). 

Cells to the beginning of the 
worksheet 

Select the first cell, and then press CTRL+SHIFT+HOME to extend the 
selection of cells to the beginning of the worksheet. 

More or fewer cells than the 
active selection 

Hold down SHIFT while you click the last cell that you want to 
include in the new selection. The rectangular range between the 
active cell and the cell that you click becomes the new selection. 
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Notes 

 To cancel a selection of cells, click any cell on the worksheet. 

 Excel marks selected cells or ranges by highlighting them. These highlights do not appear in a 
printout. If you want to display cells with a highlight when you print a worksheet, you can use 
formatting features to apply cell shading.  

 If the selection is extended when you click a cell or press keys to move around, it may be because 
F8 or SHIFT+F8 have been pressed to extend or add to the selection, displaying Extend Selection, 
or Add to Selection on the status bar: To stop extending or adding to a selection, press F8 or 
SHIFT+F8 again. 

 

Select the contents of a cell 

To select the contents of a cell Do this 

In the cell Double-click the cell, and then drag across the contents of the cell 
that you want to select.  

In the formula bar: 

  

Click the cell, and then drag across the contents of the cell that 
you want to select in the formula bar. 

By using the keyboard Press F2 to edit the cell, use the arrow keys to position the 

insertion point, and then press SHIFT+ARROW key to select the 
contents. 
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Select rows and columns in an Excel table 

To select Do this 

A table column 
with or without 
headers 

Click the top edge of the column header or the column in the table. The 

selection arrow will appear to show you that clicking selects the column.  

You can also click anywhere in the table column, and then press CTRL+SPACEBAR,  

A table column 
with worksheet 
headers  

Click the worksheet column heading that displays the table header of the table 
column that you want to select.  

OR 

You can also click anywhere in the table column, and then press CTRL+SPACEBAR. 

A table row Click the left border of the table row. The following selection arrow will 
appear to show you that clicking selects the row.  

All table rows 
and columns 

Click the upper-left corner of the table. The following selection arrow 
appears to indicate that clicking selects the entire table.  

You can also click anywhere in the table, and then press CTRL+A, or you can click the 
top-left most cell in the table, and then press CTRL+SHIFT+END. 

 

 

Select one or multiple worksheets 

By clicking the tabs of worksheets (or sheets) at the bottom of the window, you can quickly select a 
different sheet.  

Note If you want to enter or edit data on several worksheets at the 

same time, you can group worksheets by selecting multiple sheets.  

You can also format or print a selection of sheets at the same time. 
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To select Do this 

A single sheet Click the sheet tab.  

 

If you don't see the tab that you want, click the tab scrolling buttons to 
display the tab, and then click the tab. 

 

Two or more adjacent 
sheets 

Click the tab for the first sheet. Then hold down SHIFT while you click the tab 
for the last sheet that you want to select. 

Two or more 
nonadjacent sheets 

Click the tab for the first sheet. Then hold down CTRL while you click the tabs 
of the other sheets that you want to select. 

All sheets in a workbook Right-click a sheet tab, and then click Select All Sheets on the shortcut menu. 

 

 

 

Notes 

 Group: When multiple worksheets are selected, [Group] appears in the title bar at the top of the 

worksheet. To cancel a selection of multiple worksheets in a workbook, click any unselected 
worksheet. If no unselected sheet is visible, right-click the tab of a selected sheet, and then click 
Ungroup Sheets on the shortcut menu. 

 Data that you enter or edit in the active sheet is reflected  

 Shortcut menu: A menu that shows a list of commands relevant to a particular item. To display 

a shortcut menu, right-click an item or press SHIFT+F10 
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 Active sheet: The sheet that you're working on in a workbook. The name on the tab of the active 

sheet is bold. 

 

 

Use the arrow keys to move through a worksheet 

To move between cells on a worksheet, click any cell or use the arrow keys. When you move to a cell, it 
becomes the active cell 

To scroll Do this 

To the start and end of ranges Press CTRL+ARROW key to scroll to the start and end of each range in 
a column or row before stopping at the end of the worksheet.  

To scroll to the start and end of each range while selecting the 
ranges before stopping at the end of the worksheet, press 
CTRL+SHIFT+ARROW key. 

One row up or down Use the UP ARROW key or DOWN ARROW key to scroll one row up or 
down. 

One column left or right Use the LEFT ARROW key or RIGHT ARROW key to scroll one column 
left or right. 

One window up or down Press PAGE UP or PAGE DOWN. 

One window left or right Press SCROLL LOCK, and then hold down CTRL while you press the 
LEFT ARROW or RIGHT ARROW key. 

A large distance Press SCROLL LOCK, and then simultaneously hold down CTRL and an 
arrow key to quickly move through large areas of your worksheet. 
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Use the scroll bars to move through a worksheet 

 

 

 

To scroll Do this 

One row up or down 
Click the scroll arrows or on the vertical scroll bar to move the 
sheet one row up or down.  

One column left or right 
Click the scroll arrows or on the horizontal scroll bar to move 
the sheet one column to the left or right. 

Scroll through a worksheet with 
increased scroll speed 

While scrolling, hold down the mouse at the farthest end of the screen 
for more than 10 seconds to increase the scrolling speed.  

Moving the mouse in the opposite direction slows down the scroll 
speed. 

One window up or down 
Click above or below the scroll box on the vertical scroll bar. 

One window left or right 
Click to the left or right of the scroll box on the horizontal scroll 
bar. 

A large distance 
Hold down SHIFT while dragging the scroll box . 
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Notes 

 When you use the scroll boxes to move through a worksheet, Excel displays a tooltip to indicate 
row numbers or column letters (or numbers if you specified to use R1C1 reference style for the 
workbook) so that you know where you are in the worksheet.  

 The size of a scroll box indicates the proportional amount of the used area of the sheet that is 
visible in the window. The position of a scroll box indicates the relative location of the visible 
area within the worksheet.  

 You can quickly split the window so that you can scroll in two or four panes 
simultaneously. Point to the split box on either the vertical or the horizontal scroll 

bar. When the pointer becomes a double-headed arrow , drag the split bar onto the 
worksheet where you want to split the window. Double-click the split bar to remove it. 

 

Scroll and zoom using the mouse 

Some mouse devices and other pointing devices, such as the Microsoft IntelliMouse pointing device, have 
built-in scrolling and zooming capabilities that you can use to move around and zoom in or out on your 
worksheet or chart sheet. . You can also use the mouse to scroll in dialogue boxes that have drop-down 
lists with scroll bars. For more information, see the instructions for your pointing device. 

To Do this 

Scroll up or down a few rows at a time Rotate the wheel forward or back. 

Scroll through a worksheet with increased 
scroll speed 

While scrolling, hold down the mouse at the farthest end of 
the screen for more than 10 seconds to increase the 
scrolling speed.  

Moving the mouse in the opposite direction slows down the 
scroll speed. 

Pan through a worksheet Hold down the wheel button, and drag the pointer away 

from the origin mark in any direction that you want to 
scroll. To speed up scrolling, move the pointer away from 
the origin mark. To slow down scrolling, move the pointer 
closer to the origin mark. 

Pan through a worksheet automatically Click the wheel button, and then move the mouse in the 
direction that you want to scroll. To speed up scrolling, 
move the pointer away from the origin mark. To slow down 
scrolling, move the pointer closer to the origin mark. To 
stop automatic scrolling, click any mouse button. 

Zoom in or out Hold down CTRL while you rotate the IntelliMouse wheel 
forward or back. The percentage of the zoomed worksheet 
is displayed on the status bar. 

Show detail in outlines Point to a cell that summarizes data in the outline, and 
then hold down SHIFT while you rotate the wheel forward. 
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Hide detail in outlines Point to any cell that contains detail data, and then hold 
down SHIFT while you rotate the wheel back. 

 

 

Formative Assessment 1 
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Computer System Processes 

Outcome 

Identify and select the appropriate computer system process.  

Outcome Notes  

Identify and select the appropriate computer system process (inputs and actions) to reflect a required 
physical operation being recorded, performed or produced (e.g. recording storage allocation of freight, 
printing a document, accessing information from a computerised inventory management system).  

 

Assessment criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  

 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  

 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  

  



27 | P a g e  

 

Inputs And Actions 
The basic format for storing data in an Excel database is a table. In a table, data is entered in rows. Each 
row is known as a record.  

Once a table has been created, Excel's data tools can be used to search, sort, and filter records in the 
database to find specific information.  

Although there are a number of ways you can use these data tools in Excel, the easiest way of doing so is 
to create what's known as a list from the data in a table.  

 

 

 

To enter data quickly: 

1. Type the first two names that are on the price labels – Game1-01 and Game1-02 into cells A4 and 
A5 respectively. 

2. Drag select the two ID's to highlight them. 
3. Click on the fill handle and drag it down to cell A13.  
4. The rest of the Price labels should be entered into cells A6 to A13 correctly. 

Note: 

 

Use Autofill 

This option allows you to enter a series into a worksheet. You can automatically fill in dates, time periods 
and series of numbers, including numbers combined with text. AutoFill works both horizontally and 
vertically.   
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Use the fill handle to fill data 

You can use the Fill command to fill data into worksheet cells. You can also have Excel automatically 
continue a series of numbers, number and text combinations, dates, or time periods, based on a pattern 
that you establish. However, to quickly fill in several types of data series, you can select cells and drag 
the fill handle.  This is the small black square in the lower-right corner of the selection. When you point to 

the fill handle, the pointer changes to a black cross. . 

After you drag the fill handle, the Auto Fill Options button appears so that you can choose how the 
selection is filled. For example, you can choose to fill just cell formats by clicking Fill Formatting Only, or 
you can choose to fill just the contents of a cell by clicking Fill Without Formatting. 

 

 

 

Entering Data Correctly 

The first step in creating an Excel database is to enter the data. When doing so, it is important to ensure 
that it is entered correctly.  

Data errors, caused by incorrect data entry, are the source of many problems related to data 
management. If the data is entered correctly in the beginning, the program is more likely to give you back 
the results you want.  

 



29 | P a g e  

 

Rows are Records 

As mentioned, rows of data, in a database are known as records. When entering records keep these 
guidelines in mind:  

 Leave no blank rows in the table being created, not even between the headings and the first row 
of data. 

 A record can contain data about only one specific item.  

 A record must also contain ALL the data in the database about that item. There can't be 
information about an item in more than one row. 

 

Columns are Fields 

While rows in an Excel database are referred to as records, the columns are known as fields. Each column 
needs a heading to identify the data it contains. These headings are called field names.  

 Field names are used to ensure that the data for each record is entered in the same sequence.  

 Make sure that all the data in a column is entered using the same format. If you start entering 
numbers as digits (such as 10 or 20) keep it up. Don't change part way through and begin entering 
numbers as words (such as ten or twenty). Be consistent. 

 Leave no blank columns in the table. 
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Create the list 

Once the data has been entered into the table, it can be converted to a list.  

When you are working on a datasheet inputting the same type of data in the cells, it would become very 
monotonous to type same data over and over again. To prevent typing same data, you can make a list of 

data that will be used for any number of times, Excel 2010 provides a  Data Validation feature which is 

very handy for making lists. 

To do so:  

Go to Cell A15 and type the 
title Price Labels in it. Next: 

1. Go to Cell A16 and 
highlight from A16 to 
A27 

 

 

 

 

 

 

 

 

 

 

 

 

2. Switch to Data tab and click Data Validation 
3. Click In Cell drop-down check box and select List from the Data Validation dialog. Select source 

field from where you want to make a list. 
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4. Now select the Source field and click button in Data Validation dialog. (Highlight from A4 to A13)  

  

 

 

 

 

 

 

 

 

 

 

 

 

5. You will reach Data Validation Dialog again, click OK  
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6. You will notice that a drop down button is 
attached with every cell in Price Labels field 
(A16 to 27) that include the info on the price 
labels of the games in the shop. 

Click the drop down buttons to fill the Price Label fields. 

 

 

 

 

 

 

 

 

Using the Database Tools 

Sorting data is an integral part of data analysis. You might want to arrange a list of names in alphabetical 
order, compile a list of product inventory levels from highest to lowest, or order rows by colours or icons. 
Sorting data helps you quickly visualize and understand your data better, organize and find the data that 
you want, and ultimately make more effective decisions 

In your Game Inventory workbook: 

Add the names of the client who ordered the games in column E under the heading: Customer  

Type the names of the customers who ordered the games in the same order as in the image below. 
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Sorting Data  

 To sort this data alphabetically, highlight cells E3 to E13.  Open the Data Ribbon and click on the 
A-Z button in the Sort & Filter group. 

 You will get a popup message asking if you want to sort the data next to the selection (your 
selection is the highlighted cells E3-13) or continue with the current selection only.   

 If you select “Expand the selection”, Excel will sort all the data in the rows next to the name 
along with sorting the names alphabetically, for example Game 1-10, GTA2, 18 and 1st Person will 
stay next to R.Hlatswayo when the name is sorted alphabetically.   

 If you select “Continue with the current selection”, Excel will sort only the names and leave the 
rest of the data as it is, but that means the client names will no longer be in the same row as the 
product they ordered. 

 Click on “Continue with the current selection” for now.   
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YOUR SPREAD SHEET SHOULD NOW LOOK LIKE THIS: 

 

 

Note that the names are now in alphabetical order, however they are not in the correct rows according to 
what the customers have ordered from the store inventory.  

Next, click the Undo button to get the names back the way they were.  Repeat the steps as before but this 
time select “Expand the selection”.   

Your sheet should look like the one below: 
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Note that the data in columns A to D stayed with the Customer names for example Game 1-03 and the 
details following it in the next columns is now in row  

 

Formative Assessment 2 

 

Print Preview Your Worksheet 
Whenever you want to print a worksheet, always first go to print preview to see what your worksheet will 
look like when it is printed.  

Preview your worksheet 

 Go to the File tab and click Print  

 The Preview is shown on the right 

  

Formatted: Heading 3

Formatted: Font: Trebuchet MS
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 Click the Microsoft Office Button  , 
point to the arrow next to Print, and 
then click Print Preveiw 

 On the File Menu, point to Print, and 

then click Print Preview 

 Click of the buttomes on the Ribbon to 
preview the page or make changes 
before you print 

 To preview the next and previous page, 

in the Preview group, click Next Page 

and Previous Page 

 To view page margins, in the Preview 

group, select the Show Margins check 
box 

 This displays the margins in the Print 
Preview.  To make changes to the 

margins, you can drag the margins to 
the height and width that you want, you 
can also change the column widths by 
dragging handles at top of print preview 
page. 

 

 

  

Formatted: Font: Trebuchet MS,
Strikethrough
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Printing The Document 

Printing options 

 Go to the File tab and click Print  

 Your printing options will be displayed 

 Print selection 

 Select the text that you want to print 

 Go to the File tab and click Print  

 Click the arrow next to print active 
sheets 

 Select Print Selection 

 Print active sheets 

 Select this option to print only the 
active sheets 

 OR 

 Select the pages you want to print 

Formatted: Font: Trebuchet MS

Formatted: Heading 4,  No bullets or
numbering, Tab stops: Not at  1.27 cm

Formatted: Heading 4,  No bullets or
numbering, Tab stops: Not at  1.27 cm

Formatted: Bulleted + Level: 1 +
Aligned at:  0.63 cm + Indent at:  1.26
cm, Tab stops: Not at  1.27 cm

Formatted: Strong, Font: Trebuchet
MS

Formatted: Normal,  No bullets or
numbering, Tab stops: Not at  1.27 cm

Formatted: Bulleted + Level: 1 +
Aligned at:  0.63 cm + Indent at:  1.26
cm, Tab stops: Not at  1.27 cm
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Print one sided 

 This option will print only one side of the page. 

 To print both sides, select print on both sides 

 

 

Collated 

Will collate the pages when you print more than one copy of the document 

Orientation 

Use this option to change the orientation of your workbook to portrait or landscape 

A4 

This option allows to select the size of the page 

Margins 

Select the size of the margins for your printed workbook 

 

Page setup 

Print gridlines 

 Click Page Setup and select the Sheet tab 

 Click the Print Gridlines box 

Print Row Labels On All The Sheets 

 Click Page Setup, and then click the Sheet tab. 

 Click Columns to repeat at left, and then enter the entire columns that contain the row labels.  

 

To Print Column Headings On All The Sheets 

 Click Page Setup, and then click the Sheet tab. 

Formatted: Heading 4

Formatted: List Bullet 2, Bulleted +
Level: 1 + Aligned at:  0.63 cm +
Indent at:  1.26 cm

Formatted: Normal

Formatted: Heading 4

Formatted: Heading 4

Formatted: List Bullet 2, Bulleted +
Level: 1 + Aligned at:  0.63 cm +
Indent at:  1.26 cm

Formatted: Strong, Font: Trebuchet
MS, Font color: Auto, English (U.K.)

Formatted: Strong, Font: Trebuchet
MS, Font color: Auto, English (U.K.)

Formatted: Strong, Font: Trebuchet
MS, Font color: Auto, English (U.K.)

Formatted: Normal

Formatted: Strong, Font: (Default)
Trebuchet MS, 10 pt, Not Bold

Formatted: Strong, Font: (Default)
Trebuchet MS, 10 pt, Not Bold

Formatted: Heading 4

Formatted: Strong, Font: (Default)
Trebuchet MS, 10 pt, Not Bold

Formatted: Strong, Font: (Default)
Trebuchet MS, 10 pt, Not Bold
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 Click Rows to repeat at top, and then enter the rows that contain the column labels. Restore a split 
window to a single pane 

 

Add headers or footers to your workbook 

 Click Page Setup, and then click the Header/Footer tab. 

 Enter the details for the header or footer as required a partial or entire worksheet or workbook 

 

Formative Assessment 3 
  

Formatted: List Bullet 2, Indent: Left: 
0.5 cm, Bulleted + Level: 1 + Aligned
at:  0.63 cm + Indent at:  1.26 cm, Tab
stops:  1.13 cm, List tab

Formatted: Heading 4

Formatted: List Bullet 2, Indent: Left: 
0.5 cm, Bulleted + Level: 1 + Aligned
at:  0.63 cm + Indent at:  1.26 cm, Tab
stops:  1.13 cm, List tab
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Access Data 

Outcome 

Access data and integrate the data across compatible computer programs.  

Outcome Notes  

Access data and integrate the data across compatible computer programs within a specific computer 
system (e.g. via Internet between Word and Excel).  

Assessment criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  

 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  

 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  
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Copy and move text between documents/programs 

Text can be copied and moved between documents and certain programs by using the Copy and Paste 
buttons on the Home ribbon in the Clipboard group.  

 

 

 

 

 

 

 

The Clipboard is a temporary storage area used by Windows to hold data while it is being moved or 

copied.  

The Clipboard can be used to transfer information within the same file, between two files of the same 
type, or between two files in different applications, such as Word and Excel. 

u will find the clipboard in most Microsoft Office applications such as Word, Excel, PowerPoint, Publisher 
etc.   

Example: 

 To copy text from MS Word to MS Excel, open the Word document named Caspian Sea facts and 
open MS Excel.   

 Highlight the bulleted text 

 Click on Copy in the Clipboard Group 

 Click on MS Excel on the Task bar 

 Highlight the cells in Excel where you want to paste the text 

 Click down arrow below Paste in the Clipboard group, and click on Match Destination Formatting 

 

 

 

 

 

 

 

 

 

 

 

 

 



42 | P a g e  

 

 

 

Also, if both documents are open the data can be dragged from one to the other. 

 Display the text or graphics you want to move or copy in one window 

 Display the destination for the text or graphics in the other window 

 Select the text or graphics 

 Drag the text or graphics from the first window to the second window 

 

Importing data 
Microsoft Office provides drivers that you can use to retrieve data from the following data sources: 

 Microsoft SQL Server OLAP Services (OLAP provider)  

 Microsoft Access  

 dBASE  

 Microsoft FoxPro  

 Microsoft Excel  

 Oracle  

 Paradox  

 SQL Server  

 Text file databases  

 Third-party providers  

By importing data, you don't have to retype the data you want to analyze in Microsoft Excel. You can also 
update your Excel reports and summaries automatically from the original source database whenever the 
database is updated with new information. 
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Importing data from databases and files 

You can import data to Excel from most data sources by going to the Data tab, Get External Data 

group 

Note To bring external data into Microsoft Excel, you must have 

access to the data. If the external data source you want to access is not on 

your local computer, you might need to contact the administrator of the 

database for a password, user permission, or other connection 

information. 

 You can retrieve data from the following data sources: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 You can use objects (data such as text, pictures, spreadsheets, and so on) in Word, Excel, 

PowerPoint, and Outlook by copying data from the source application and pasting in the target 

file (or by using drag-and-drop).  

 You can also insert whole new objects in a file and edit them in their source application. Using 

objects like this is called embedding. 

 When you embed an object, you can edit it using the original application that created it. 
However, if you want to insert data that is regularly updated (for example, sales data from a 

spreadsheet inserted in a company report) you can create a link to the source file. This saves you 

from copying and pasting a new object every time the source file is updated. 

 

Working with Access data in Excel 

You may want to work with Access data in an Excel workbook in order to take advantage of the data 
analysis and charting features, the flexibility in data arrangement and layout, or the functions in Excel 
that are not available in Access. 

To bring data into Excel from Access, you can  

 copy data from an Access datasheet and paste it into an Excel worksheet,  

 connect to an Access database from an Excel worksheet, or  

 export Access data into an Excel worksheet 
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Connecting to Access data from Excel 

To bring refreshable Access data into Excel, you can create a connection to the Access database and 
retrieve all of the data from a table or query. For example, you may want to update an Excel summary 
budget report that you distribute every month so that it contains the current month's data. 

 Go to the Data tab, Get External Data group and select From Access 

 Select the file containing the data you need 

Exporting Access data to Excel 

 By using the Export Wizard in Access, you can export an Access database object (such as a table, 
query, or form), or selected records in a view into an Excel worksheet. When you perform an 
export operation in Access, you can save the design of that operation for future use and even 
schedule the export operation to run automatically at specified intervals. 

OR 

 Copy the data from the access datasheet and paste it into your Excel worksheet 

 

Import data from the Web 

Web pages often contain information that is perfect for analysis in Excel. For example, you can analyse 
stock quotes in Excel by using information that comes directly from a Web page. 

 Go to the Data tab, Get External Data group and select From Access 

 

 

 Enter the URL of the web page that has the information you need 

 Follow the steps as dictated by dialogue boxes 
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You can use a Web query to retrieve data stored on your intranet or the Internet, such as a single table, 
multiple tables, or all of the text on a Web page, and analyse the data by using the tools and features in 
Excel. With the click of a button, you can easily refresh the data with the latest information from the Web 
page. For example, you can retrieve and update stock quotes from a public Web page, or retrieve and 
update a table of sales information from a company Web page. 

 

Formative Assessment 4 
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Data Security and Integrity 

Outcome 

Take appropriate action to ensure the security and integrity of data.  

Outcome Notes  

Take appropriate action to ensure the security and integrity of data (e.g. daily backups, password 
protection, anti-virus checks within workplace policies and guidelines) taking cognisance of organisational 
security procedures.  

Assessment criteria 

 Produce outputs which correctly reflect the required result with respect to accuracy, presentation 
content and timeliness, and are performed efficiently.  

 Use workplace colloquial and technical language and communication technologies in the 
workplace context.  

 Set up and shut down computer equipment (e.g. shut down procedures for software applications 
are followed).  

 Select and operate software appropriate to the task from a defined range of software options 
including electronic communication tools.  

 Demonstrate ability to follow safe working and security procedures pertaining to the utilisation of 
computer equipment and data management respectively.  

 Demonstrate appropriate responses to routine errors and violation messages to overcome the 
problem.  

 Identify and demonstrate effective use of hardware (e.g. mouse speed, keyboard skills) 
components relative to task at hand within a predetermined operating environment and within a 
selected computer system.  

 Demonstrate the sequence of events required for the effective operation of specific software 
packages and elementary integration of data across compatible programs (e.g. moving of table 
from Excel in Microsoft Word).  

 Suggest improvements to office environment (e.g. work station equipment is adjusted to meet 
ergonomic requirements), giving cognisance to advanced technology and health requirements.  
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Viruses 
In today's computing world, you must prevent intentional intrusions into your computer and network that 
take the form of viruses and Trojan horses.  

A virus is a program that attempts to spread from computer to computer and either cause damage (by 
erasing or corrupting data) or annoy users (by printing messages or altering what is displayed on the 
screen). 

A Trojan Horse is a program that masquerades as another common program in an attempt to receive 
information. An example of a Trojan horse is a program that behaves like a system logon to retrieve user 
names and password information that the writers of the Trojan horse can later use to break into the 
system. 

Follow these tips to help prevent virus outbreaks and Trojan horse attacks. 

Educate yourself 

Educate yourself about viruses and how they are commonly spread. You can unwittingly bring viruses into 
the network by loading a program from a source such as the Internet, online bulletin board, or e-mail 
attachments.  

Learn the common signs of viruses 

 Unusual messages that appear on your screen,  

 Decreased system performance,  

 Missing data,  

 And inability to access your hard drive.  

If you notice any of these problems on your computer, run your virus-detection software immediately to 
minimize the chances of losing data.  

Warning: Programs on flash drives may also contain viruses.  

Scan all disks before copying or opening files from them, or starting your computer from them.  

Have at least one commercial virus-detection program and use it regularly to check your computers for 
viruses. Be sure to obtain the latest virus signature files for your program when they are available, 
because new viruses are created every day. 

Back up your work 

Make regular back-ups of your work, either on flash drives or CDs. 

 

Defective Equipment 
At times it happens that the flash drive you are using develops bad sectors, meaning that it is not able to 
store and download information as before.  

If you do not handle your hard drive in the correct manner, it could crash and flash drives can be broken.  
When this happens, the information on the device will be lost. 

Hard drives are hardy and well-made and, if handled correctly, should not crash.  The following are 
examples of things that can cause a hard drive to crash: 

 Viruses 

 Shutting down the computer without following the proper shut down procedures 

 Dropping the hard drive or handling it roughly. 
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 The best way to ensure that you do not lose information,  is to make regular backups of your 
work.   

 You should also check flash drives regularly for bad sectors.  This is done automatically when you 
format a flash drive. 

 Always handle computer equipment with tender, loving care.  They are electronic devices and 
even something such as a hard knock can cause damage. 

 Do not leave your equipment in the sun or rain and run checks on the equipment on a regular basis 

 

Protecting Files From Unauthorised Access 
You can't use a password to protect files and folders in Windows. However, some programs that run on 
Windows allow you to protect individual files with a password. For more information, check the Help for 
the program you're using. 

There are other ways to protect your files and folders in Windows. You can  

 encrypt your files using Encrypting File System (EFS),  

 manually specify who can access the folders or files by setting permissions,  

 or hide them. 

Choose your method based on how secure the folders or files need to be. Encrypting is the most secure, 
while hiding the folders is the least secure 

Permissions 

Permissions are rules associated with objects on a computer or network, such as files and folders.  

Permissions determine whether you can access an object and what you can do with it. For example, you 
might have access to a document on a shared folder on a network. And even though you can read the 
document, you might not have permissions to make changes to it 

Only system administrators and people with administration accounts on computers can assign permissions 
to individual users or groups. 

The table lists the permission levels that are typically available for files and folders. 

Permission 
level 

Description 

Full control 
Users can see the contents of a file or folder, change existing files and folders, create 
new files and folders, and run programs in a folder. 

Modify Users can change existing files and folders, but cannot create new ones. 

Read and 
execute 

Users can see the contents of existing files and folders and can run programs in a folder. 

Read Users can see the contents of a folder and open files and folders.  

Write Users can create new files and folders and make changes to existing files and folders. 
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Check the permissions of a file or folder 

 Right-click the file or folder, and then click Properties. 

 Click the Security tab. 

 Click a user name or group under Group or user names. 

The permissions for the selected user or group are shown in the lower portion of the properties dialog box. 

Hide a file 

Although you usually can't see a hidden file, it's an ordinary file in all other respects. You can choose 
whether a file is hidden or visible by changing its properties. Here's how to do this:  

 Right-click a file icon, and then click Properties. 

 Next to Attributes, select the Hidden check box, and then click OK. 

 

Show hidden files 

 Open Folder Options in the Control Panel 

 Click the View tab. 

 Under Advanced settings, click Show hidden files, folders, and drives, and then click OK. 

You can hide rarely used files to reduce clutter, but remember that hidden files still take up space on your 
hard drive. 
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Note: Although you can hide confidential files so other people can't see 

them, you shouldn't rely on hidden files as your only means of security or 

privacy.  

Recommend that others open the document as read-only 

You can suggest, but not require, that users open a document as read-only. If a user opens the document 
as read-only and then changes it, that person can save the document only by giving it a different file 
name.  

 Open the document. 

 On the Review tab, in the Protect group, click Protect Document. 

 Click Restrict Formatting and Editing. 

 In the Restrict Formatting and Editing task pane, under Formatting restrictions, Editing 
restrictions, and Start enforcement, make the selections that meet your formatting and 

editing needs. 

 

 

 

 

 

 

 

 

 

Back-Up Files Using The Operating System 
The Backup utility helps you create a copy of the data on your hard disk. In the event that the original 
data on your hard disk is accidentally erased or overwritten, or becomes inaccessible because of a hard 
disk malfunction, you can use the copy to restore your lost or damaged data. 

 Click Start, point to Control Panel, and then click Backup and restore. 

 

 

javascript:HelpPopup('wdtip9.hlp','wohowReadonly');
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 Once you have clicked on Backup, click on Backup Now or set up your backup schedule for 

regular backups. 

 

 

 



52 | P a g e  

 

Different Backup Devices  

Where should I save my backup? 

Where you save your backup depends on the hardware that you have available and the information you are 
saving on your backup. For the most flexibility, we recommend that you save your backup on an external 
hard drive. 

The table lists the types of backup destinations that Windows Backup supports and the advantages and 
disadvantages of each. 

Destination 
Type 

Advantages Disadvantages 

Internal 
hard drives 

Hard drives are relatively inexpensive 
and aren't affected if you have a 
problem with your operating system. You 
can even install the drive in another 
computer if you buy a new computer and 
you still want to use the disk for 
backups. 

Notes 

Another hard drive isn't the same thing 
as a partition. You can save your backups 
on a partition on your drive, but if the 
drive were to fail, you would lose your 
backups.  

You should also never back up files on 
the same drive that Windows is installed 
on, because if your computer gets a virus 
or has a software failure, you might have 
to reformat the drive and reinstall 
Windows to recover from the problem 
and then you would lose your backup 
data. 

Internal hard drives are more secure 
than other media because they aren't 
being moved around, which makes it less 
likely that they will crash or become 
damaged. 

Internal hard drives are more efficient 
than external hard drives or removable 
media. 

If your computer doesn't already have another 
hard drive, you need to install one, or have 
someone install it for you. 

If you have a problem with your computer, you 
can still use the drive by moving it to another 
computer, but you need to know how to install it 
in the new computer or have someone install it for 
you. 

Since the hard drive is installed inside your 
computer, you can't store it in a location separate 
from your computer, such as in a fireproof safe. 

External 
hard drives 

An external hard drive can easily be 
attached to your computer using a USB 
port.  

External hard drives can hold lots of 
information. We recommend that you 
use an external hard drive that holds at 
least 200 GB. 

External hard drives can be stored in a 

The external hard drive needs to be plugged into 
your computer and available when a backup is 
scheduled to occur. If you store your hard drive 
somewhere else for safe keeping, you'll need to 
remember to get it out and attach it to your 
computer before your backup is scheduled. 

mshelp://windows/?id=75f2da20-91f7-4f31-8e17-798cce2c38c1#gtmt_partition_def
mshelp://windows/?id=d2f7b850-ff77-499b-9b4e-bdc08e3ae4d1#gtmt_removable_media_def
mshelp://windows/?id=d2f7b850-ff77-499b-9b4e-bdc08e3ae4d1#gtmt_removable_media_def
mshelp://windows/?id=f7599a7b-bd44-41fc-bc0b-de86082d3951#gtmt_app_usb_ports_def
mshelp://windows/?id=f7599a7b-bd44-41fc-bc0b-de86082d3951#gtmt_app_usb_ports_def


53 | P a g e  

 

Destination 
Type 

Advantages Disadvantages 

location that is separate from your 
computer, such as a fireproof safe, 
which can help protect your backup. 

Writeable 
CDs or DVDs 

Many newer computers have CD or DVD 
burners installed in them. 

CDs and DVDs are relatively inexpensive 
and are easy to find in most department 
and electronics stores. 

You can store the CDs or DVDs in a 
location that is separate from your 
computer, such as a fireproof safe. 

You can't save scheduled system image backups on 
CDs or DVDs. 

Depending on how much data you have, it might 
take several CDs or DVDs to hold your backup and 
you would need to store and keep track of all of 
them. 

CDs or DVDs can become corrupted over time. 

USB flash 
drives 

USB flash drives are relatively 
inexpensive and can hold a fair amount 
of data. To save a backup on a flash 
drive, it must be able to hold more than 
1 GB.  

You can store a flash drive in a location 
that is separate from your computer, 
such as in a fireproof safe. 

You can't save a system image on a flash drive. 

Depending on the size of your flash drive, it could 
fill up quickly, which means you won't be able to 
keep copies of older backups. 

Network 
locations 

If your computer is on a network, a 
shared folder or drive on the network 
can be a convenient place to save your 
backup as they don't require you to have 
storage space on your computer. 

You can only save your backups on a network 
location on Windows 7 Professional, Windows 7 
Ultimate, and Windows 7 Enterprise.  

You'll need to provide a user name and password 
so that Windows Backup can access the network 
location. If you can access the network location 
from the Computer folder on your computer 
without having to enter a user name or password, 
type the user name and password that you used to 
log on to the computer into the Windows Backup 
UI. If you aren't able to access the network 
location from the Computer folder on your 
computer, you'll need to create a user account on 
the network computer and type the user name and 
password for that user account into the Windows 
Backup wizard. 

The network location must be available at the 
time the backup is scheduled to occur and the 
user name and password that you provided when 
you set up your backup needs to still be valid for 
the network location. 

Other people who have access to the network 
location might be able to access your backup. 

If you create a system image, Windows will only 
keep the latest version of the system image. 
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Save Your File In A Different Location 

When you make a backup, it’s not necessary to use the backup facility every time.  You can also just save 
a copy of the file or folder in a different location like on a memory stick or a CD. 

 Open the document that you want to backup 

 Click on the File tab and select Save As: 

You can choose if you want to save to a memory stick or CD.   

 Select the location where you would like to save the backup in the left hand pane,  

 Give the file a name  

 Select a save as type.  Windows will normally put the right save as type in for you.  Like when you 
save a word document, it is saved as a word document.   

 Click on Save.  

 If you are using a CD writer, the CD will then start copying the data. 
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Formative Assessment 5 

 

Office Environment 

Working Environment 

Note Ergonomics is the study of factors affecting the performance of 

people at work. It is well established that a bad working environment can 

cause certain health problems. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

http://en.wikipedia.org/wiki/File:Computer_Workstation_Variables.jpg
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To assess the fit between a person and their work, ergonomists consider the job being done and the 
demands on the worker; the equipment used (its size, shape, and how appropriate it is for the task), and 
the information used (how it is presented, accessed, and changed). 

Eyestrain and Headaches 

Looking at a monitor for long periods without a break can make your eyes tired and cause headaches. 
Using a good quality monitor that produces a clear image on the screen may help reduce this problem. 
Adequate lighting should also be provided. 

Repetitive Strain Injury (RSI) 

RSI is a complaint that occurs when the same task is carried out repeatedly for a long period, making use 
of the same muscles continuously. Using ergonomically designed, angled keyboards and moulded mice may 
reduce the risk of strain injury: 

 When you use a mouse, keep your wrist straight and rest your palm on the body of the mouse. 

 When using a keyboard, keep your forearms parallel with the keyboard. 

With both devices  

 avoid working with your wrists bent,  

 do not hunch your shoulders or bend forwards,  

 and take frequent breaks (to stretch or walk around for instance) 

 

Back Pain 

Sitting at a desk in a poor position can cause lower back pain. This is especially true if you sit for a long 
period without getting up. To help prevent back pain: 

 A monitor and workstation should be positioned at the correct height.  

 Chairs should provide support for the back and neck.  

 You should be able to sit up straight with the screen at slightly below eye level. You should be 
able to rest your feet on the floor comfortably.  

 Your wrists should be supported as you type with your forearms parallel with your legs. 

Ventilation 

Adequate ventilation is also important when using computer equipment. Computers and monitors give off 
a lot of heat and make the surrounding air very dry. This can cause your eyes and throat to become dry 
and uncomfortable if there is an insufficient supply of fresh air. 
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Use and Care of Computer Equipment 
Many organisations have an IT support department to take responsibility for the management of computer 
systems and the training of users. If something goes wrong with computer hardware or software, you 
should usually contact them in the first instance. 

Remember to supply details of the problem, including any error messages or codes that are displayed on 
the screen and exactly what you were doing with the system at the time of the error. 

Taking care of your computer 

 Never move the computer when it is switched on 

 Never obstruct the ventilation holes in the monitor or the computer's case 

 Never eat or drink near the computer 

 Never store floppy disks near magnetic fields, which are created by monitors, speakers, 
microwaves and other electrical devices 

 Always keep your computer in a clean, dry, cool and dust free place and away from radiators or 
hot lamps 

 

 

Formative Assessment 6 
 


